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OVERVIEW 
 

The UCS-20 is a fully integrated multichannel analyzer for nuclear 
spectroscopy and time related studies on the Macintosh computer. The 
instrument contains a high voltage supply, amplifier, multichannel scaling, a 
2048 channel analog-to-digital converter and up to 2048 channels of data 
memory, capable of storing spectra and associated elapsed time. 
 
UCS-20 Software for Macintosh 
 
Supplied software includes the following items: 

UCS20 for Mac version 1.0.0 - This is the MCA application program for the 
UCS-20 system. 

UCS20 Preferences. This is a starting point for initial application conditions. 
This file is overwritten each time the application is closed. 

ucs20.hex. This is the operating firmware for the UCS-20. It is downloaded 
to the UCS-20 when the program is launched if power was cycled since 
last loaded. 

UCS20 Notes. A text file with latest additions and corrections. 
‘OS Extensions’ Folder. This folder contains the USB drivers for 

communicating with the UCS-20. Files should be placed in the 
Extensions folder of computers running OS 8.6 and above (not OS-X 
compatible). 

‘Sample Files” Folder. This folder contains sample spectra acquired using 
the UCS-20 and saved to disk. Also contained are sample UCS Setup 
files holding high voltage, amplifier gain, presets, etc. These files may 
be opened and viewed within the UCS20 for Mac application. 

 
UCS 20 - Menus 
File 

New - Opens a blank window that is not associated with any hardware or 
opened file. This window may be used to hold a spectrum pasted from 
the clipboard. 

Open... - Opens a UCS-20 spectrum file in its own window or a UCS setup 
file containing acquisition parameters and presets. Both file types will 
appear in the standard Open File dialog box. The spectrum files are 
represented by document style icons showing a miniature spectrum. 
Setup files are document style icons filled with simulated controls and 
indicators. 

Close - Closes the current (front-most)  spectrum data window. 
Save - Standard data file saving. 
Save AS... - Standard data file renaming or changes saving. 
Save UCS Settings... - This selection will save UCS setup parameters 

including detector voltage, amplifier gains, presets, etc. 
Page Setup... - Standard print out set up. 
Print Preferences... - The check boxes select or deselect the print-out 
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features. The selection of the channel data will cause all channels 
between the first and last selections to be printed.  

Print - Activates printing as defined in Print Preferences. 
Quit - Exits the UCS-20 for Mac application. 

 
Edit 
Cut - Erases spectrum in current window and copies data to clipboard in the 

same formats as the Copy selection. 
Copy - This selection copies the currently selected spectrum into the 

clipboard. Spectrum data may be directly pasted into another spectrum data 
window from the clipboard. Clipboard data also exists in tab separated 
ASCII format for direct pasting into spreadsheets or documents. 

Paste - Pastes spectrum data into the current window. 
Clear - This selection erases the spectrum in the front window even if the 

window shows a spectrum loaded from disk. Note that this is not possible 
using the Erase control in the system control window. 

Copy Data Text Only - This selection only copies to the clipboard the ASCII 
channel data with no header or column titles. 

Strip Clipboard Spectrum - Allows the spectrum currently residing in the 
clipboard to be subtracted channel-by-channel from the spectrum in the 
current data window. This is done using live-time normalization. 

Add Clipboard Spectrum - Allows the spectrum currently residing in the 
clipboard to be added channel-by-channel to the spectrum in the current 
data window. 

Overlay Clipboard Spectrum - Allows the spectrum currently residing in the 
clipboard to be displayed as a channel-by-channel overlay with the 
spectrum in the current data window. 

Experiment Text… - Allows entry of user information about the spectrum 
being collected to be tagged with the spectrum. 

Show Clipboard - A simple clipboard text viewer. This is not a full-featured 
viewer. Only the first portion of the clipboard is displayed as an aid to see 
what is clipped. Pasting into a text editor or spreadsheet application is 
necessary to fully view or to edit the information. 

 
Mode 
Pulse Height Analysis - Sets system into standard PHA mode (default). 
Multichannel Scaling - Sets system into MCS mode where incoming events 

are counted for predetermined (Dwell) times and stored in sequential 
memory channels. This selection counts all events occurring between the 
upper and lower level discriminators. These are set using the sliders above 
the spectrum area in PHA mode. 

External Multichannel Scaling - Same as above except that events are 
counted from rear panel Ext MCS In connector. 

Mössbauer - Sets system into Mössbauer mode where incoming events are 
counted for predetermined (Dwell) times and stored in sequential memory 
channels. This selection counts all events occurring between the upper and 
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lower level discriminators. These are set using the sliders above the 
spectrum area in PHA mode. Acquisition continues to accumulate data for 
the number of passes specified in the Presets dialog. 

External Mössbauer - Same as above except that events are counted from 
rear panel Ext MCS In connector. 

 
Calculations 
Energy Calibrate... - This selection changes the system control window to 

energy calibration display to allow the system to read channels in energy 
units. Two (linear fit) or three (quadratic fit) points may be used do the 
calibration. This works by positioning the marker in a channel and clicking 
Energy to enter the energy for that channel. The radio buttons indicate 
which of the three points is being set. The energy units may also be set. 
When at least two points have been completed, clicking on Calibrate will 
initiate the calibration calculation and the marker and X axis can then be 
read in energy. 

Smooth Data - This selection does a three point averaging of the data. The 
new data will be displayed. The actual data collected in the hardware will 
not be affected and may be retrieved by choosing Raw Data or continuing 
acquisition. 

Raw Data - Retrieves the true spectrum data after a smooth selection. 
 
Tools 
IsoMatch... - The IsoMatch feature places markers in the spectrum window 

showing the significant gamma ray emissions for many common isotopes. 
This feature requires a properly energy-calibrated spectrum so that the 
markers will not be misaligned. When this feature is selected a list box 
appears with the currently defined isotope list. Use the mouse to click on 
isotopes to be labeled. To select multiple isotopes, hold down the Command 
key while clicking on an isotope item. 
The isotope list and the corresponding energies may be edited by the user 
using ResEdit on the UCS-20 application. Up to 128 isotopes may be added 
each with up to 9 energies. If editing the isotope table, always take care to 
safely back-up the application resources beforehand. 

Peak Summary - If regions of interest (ROIs) are currently set, this selection 
changes the data display from spectral to text giving the summary 
information for each ROI. 

 
Settings 
View Settings... - This selection displays a dialog box showing all the UCS 

hardware parameter settings. If the front window displays a spectrum 
loaded from disk, this dialog shows the parameters used to collect that data. 
The dialog may be exited with no action by clicking OK. If displayed as the 
result of Opening a Settings file, a button is provided for sending the 
settings to the connected UCS-20 hardware. 

Presets - One of several acquisition presets may be set when in standard PHA 
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mode. When acquisition is started, it will stop automatically when an  
active preset is reached. Preset real- and live-times are available as well as 
preset peak counts and preset integral. When preset peak counts is selected , 
acquisition will stop when any channel reaches the count. Preset integral 
must be set while the marker resides in a region of interest. When the 
counts in that region reach the preset value acquisition will stop. To activate 
or deactivate a preset use the check boxes in this dialog. When in 
Mössbauer mode, the total number of passes to be acquired is as specified 
in this dialog. 

MCS Dwell Times - In MCS or EMCS modes only this selects the time that 
events are counted in each channel. Times are selectable from a list ranging 
from 10 milliseconds to 600 seconds dwell per channel. 

Mössbauer Dwell Times - In Mössbauer or External Mössbauer modes only 
this selects the time that events are counted in each channel. Times are 
selectable from a list ranging from 100 microseconds to 6 seconds dwell 
per channel. 

Amplifier/High Voltage... - This opens a dialog which allows the coarse/fine 
gain and high voltage to be adjusted. The acquisition controls are also made 
available within this dialog for convenience. 

Conversion Gain - Sets the ADC full scale conversion channel: 256, 512, 
1024 or 2048. 

ROI Indicator - Drag the mouse to the color/pattern of choice to make it the 
new active ROI type. Subsequent ROI settings will rotate through the  
color/pattern sequence. 

Spectrum Dot Size - Choose size of dots used in drawing spectra: Small, Big 
or Huge. 

 
Window 
Stack - Stacks vertically all open spectrum windows. 
Tile - Tiles all open spectrum windows, scaling them such that they are fully 

and separately viewable. 
Window List - Provides a means of selectively bringing any open window to 

the foreground . 

Other Features and Controls 
Acquisition Controls 
Acquisition in any mode may be started by clicking the Acquire check box in 
the system control window. Small indicators will blink when acquisition is 
active. Clicking on the check box again will stop acquisition. To erase all 
acquired data click the Erase button. This does not clear any regions of 
interest that have been set or any current acquisition presets. 

 
Regions of Interest (ROIs) 

Region of Interest selection provides instantaneous computation of peak 
gross and net counts. To set a region of interest click on the Set radio button 
in the system control window. The currently selected ROI color type will be 
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displayed to the right of the Set indicator. Move the mouse to the left edge of 
the spectrum area to be selected. Click and drag across the spectrum to the 
right until the right edge of the desired region is reached. Release the mouse 
button and the enclosed area will highlight as a region of interest. To clear a 
region click the Clear radio button and click and drag the cursor across  a 
region. Release the mouse button and all channels marked as ROIs between 
the drag boundaries will be cleared. To quickly clear all ROIs select 
ClearAll. Only ROIs will be cleared. The data will remain. After setting or 
clearing ROIs the Normal button will be automatically reselected. 
 

Discriminators - ULD / LLD 
The upper and lower level discriminator settings are shown by the position 
of the sliders above the spectrum display area of a spectrum window. They 
may be changed by clicking and dragging these indicators.  While 
discriminators are being set, a small box will show the current value of the 
setting. Setting is in increments of one percent of range. 

 
INSTALLATION 

 
Your UCS-20 Universal Computer Spectrometer is designed to interface with  
most Macintosh computers running System 8.6 and higher (not OS X). 
Communication is via a USB 1.1 compatible Bus. Support is not provided for 
OS X native-mode operation but will run in Classic Emulation.  
 
It is recommended that you place all of the supplied application software into a 
folder of your choosing, such as ‘SpecTech Applications’ where you can 
readily access them for regular use. 
  
Before connecting the UCS-20 to the Macintosh, copy the contents of the ‘OS 
Extensions’ folder into the appropriate Extensions folder of your hard drive. 
Before turning on power to the UCS-20, and after the drivers are installed, 
reboot your computer. 

 
WARNING - ELECTRICAL SHOCK HAZARD 

 
TO AVOID ANY POSSIBILITY OF ELECTRICAL 
SHOCK, ALWAYS TURN OFF THE COMPUTER 
POWER BEFORE CONNECTING THE EXTERNAL 
CABLES. DANGEROUS HIGH VOLTAGE CAN 
EXIST ON THE THE EXTERNAL HV CONNECTOR 
WHEN THE UNIT IS OPERATING. NEVER REMOVE 
OR CONNECT CABLES WITH THE COMPUTER 
RUNNING. 

SERVICE BY AUTHORIZED PERSONNEL ONLY. 
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Connecting the Detector 
 
The UCS-20 is equipped with an internal Amplifier/Preamplifier allowing 
direct connection of a scintillation detector. If you plan to use this feature, 
connect the signal (anode) output of the detector tube base to the PREAMP IN 
connector on the rear of the instrument using a BNC cable and connect the 
high voltage to HIGH VOLTAGE with a MHV cable. 
 
These connectors appear similar with the MHV being slightly longer than the BNC 

When using an external amplifier system, connect the amplifier unipolar or 
bipolar output to the Direct In connector. 
 
 
Software 
 
The supplied software is detailed earlier in the Overview section. The software 
is not copy protected and making a backup copy is recommended prior to 
installing the programs on the Macintosh hard drive. 

 

BNC 

MHV 

 
- NOTICE - 

 
When installing and running the software on systems booting 
OS X, the extensions must be placed in the Extensions folder 

for System 9. Some systems have demonstrated difficulty with 
properly identifying the hardware or starting the software in 
Classic Emulation. The condition is not unique to the UCS20 
system. For this reason it may be advisable to run the System 

Preferences - Classic - Advanced control panel to Rebuild 
Desktop prior to launching the UCS20 software for the first 

time or subsequently at the first sign of startup trouble. 
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Auto-sensing Line Input 
90 to 240 VAC, 50 or 60 Hz. 

High Voltage Output. 
Positive Polarity 

External Input 
to MCS 

Input for use with 
External Amplifier 

Input for direct 
connection to PMT 

Input for use with 
External PreAmplifier 

USB Connection 

Temp. Compensation 
Sensor Input 

ADC MSB 
Output 

ROI 
Output Preamp 

Power Acquisition 
Gate In 

 

High Voltage 
Indicator 

Acquisition 
Indicator 

Input Activity 
Indicator 

Power Control 
Switch 

Power 
Indicator 
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OPERATION 
 
Once the program is running it will be necessary to configure the system 
parameters for correct operation and calibration. 
Place a gamma emitting check source near the detector face. Cs-137 is a good 
choice for many applications but other isotopes or combinations may be used. 

High Voltage and Gain. 
 
If you are using an integral NaI(Tl) detector with a voltage divider base such as 
the SPECTECH model GP-38, it will be necessary to set the high voltage and 
amplifier gain. From the menu bar select Settings, High Voltage/Amplifier... 
The following control box will appear. 

Set the high voltage to the recommended operating value found on the 
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manufacturers data sheet (normally around 500v for the GP-38). Click the ON  
button to energize the HV Out . 
 
Set the amplifier coarse gain to 8 as an initial starting value and start 
acquisition by clicking the Start button. The UCS-20 should begin collecting 
data and a spectrum of the calibration source will build on the screen. Using 
the course and fine gain controls align the peak(s) to the desired channel(s). 
If the 662 keV peak is set to channel 662 of a 1024 channel window, this will 
yield an approximate calibration of 1 keV per channel and a maximum energy 
range of 1.23 MeV which may not be sufficient for many experiments. Some 
measurements require an energy range of 2.8 MeV and the calibration should 
be set accordingly.  
 
A more accurate energy calibration may be obtained using the Energy 
Calibrate feature described elsewhere in this manual. 
 
ADC Conversion Gain. 
 
The default setting is 1024 channels. This is preferred for most scintillation 
detector applications and generally no adjustment is required. For certain uses 
such as alpha spectroscopy, it may be necessary to change this parameter to 
2048, 512 or 256 channels. 
 
From the menu bar select Setting, Conversion Gain to access the ADC 
conversion gain choices. 
 
LLD and ULD. 
 
At this stage it may be convenient to set the Lower and Upper discriminator 
levels to eliminate unwanted noise and high energy signals. If the LLD is set 
too low, detector noise may produce excessive system deadtime. Setting a 
counting window around a peak of interest can also be useful when performing 
decay studies using the MCS mode. 
 
The upper and lower level discriminators are shown by the position of the 
sliders above the spectrum display area. They may be changed by clicking and 
dragging these indicators. While the adjustment is being set, a small window 
displays the level in percent of ADC range. 

Lower Level Discriminator Upper Level Discriminator 
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Presets. 
 
Two preset time modes are available with the UCS-20. 
 
       PRESET LIVE TIME provides automatic correction for counting losses 
caused by the system deadtime. Events which occur during the pulse 
processing cycle are lost to the system so the timer is automatically updated to 
compensate for these losses. When operating at excessively high count-rates 
the deadtime meter will indicate a high value and the actual counting time may 
be more than doubled. Increasing the LLD setting can help reduce some high 
deadtime effects and is described elsewhere in this manual. 
 
       PRESET REAL TIME sets the counting timer to run for actual clocktime 
and makes no correction for losses due to deadtime effects. 
 
Both the Live-Time and Real-Time values are recorded on the UCS-20 screen 
and saved in the file during data storage. 
 
Two counting preset modes are also available in the UCS-20. These modes can 
be useful for acquiring spectra with the same counting statistics 
 
       PRESET COUNT provides for stopping acquisition when a specified 
count is reached in any channel. 
 
       PRESET INTEGRAL provides for stopping acquisition when the 
integrated counts in a selected region of interest reaches a specific total. 
 

From the menu bar select Setting, Presets. The following screen will appear. 
Check the box for the desired preset mode and enter the desired preset value. 
To turn off presets, uncheck all boxes. Only one Preset may be active at a time. 
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Regions of Interest. 
 
Region of interest (ROI) selection is an advanced feature which provides 
instantaneous computation of peak gross and net counts. These values may be 
used along with isotope decay tables and detection efficiency to calculate 
absolute or relative isotopic activities. ROI’s must not overlap and must be 
separated by at least one channel for correct area calculation. Up to 15 different 
groups of multiple ROI’s are possible using the color selector. Normally, peaks 
from a single isotope are marked in one color with separate colors used to 
differentiate different isotopes. Regions may be setup and cleared using the 
mouse controls. 

       SETTING ROI’s 
 
Click on the Set Button. 
 
Move the marker to the left edge of the peak. Click and drag the mouse over 
the peak and release the button. This will color the channels covered. Move to 
the next peak and repeat the process. A different color from the Settings menu 
will be chosen automatically after each use. 
 
After each ROI is set, the Normal button is automatically reselected. 
 
       CLEARING ROI’s 
 
To clear an individual ROI, place the marker in the desired ROI and Click on 
the Clear button. To clear all ROI’s, click the ClearAll button. Only ROI’s will 
be cleared, the data will remain. After each ROI operation, the Normal button 
is automatically reselected. 
 
Gross and Net Integrals. 
 
When the marker is positioned in a region of interest, the UCS-20 software 
automatically calculates the gross and net area of the region. In order to 
minimize statistical effects at the ROI endpoints, a 3-point averaging  
technique is applied. The contents of channels (n-1), (n), and (n+1) are 
summed and averaged to derive the content of the endpoint channel for the net 
area computation. A linear interpolation is performed between these averaged 
endpoint values and counts below the Compton edge are subtracted to arrive at 
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the net area of the peak. 

 
CALCULATIONS. 

 
The Calculations menu makes it possible to perform many advanced 
operations with the UCS-20. 
 
Energy Calibrate. 
 
The energy calibration feature allows the marker to read directly in energy 
units. Two calibration types are possible, a 2-point linear, or a 3-point 
quadratic fit. In order to perform an energy calibration, it is first necessary to 
acquire a spectrum using known isotopes. Cs-137 together with Co-60 works 
well for many applications, producing gamma lines at 32keV, 662keV, 
1173keV and 1332.5keV. 
 
Begin by Selecting the Calculations - Energy Calibrate… menu. Clear any 
residual data from the calibration screen by clicking the Clear Button. 

Click the Units Button and select the units to be used. 
 
Position the marker at the channel with the greatest counts of the first peak and 

 

NET Area 
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click the  Channel 1 button. Next click the Energy button and enter the peak 
energy value. Move the marker to the high point on the second peak to be used 
for the calibration and repeat the procedure. At this stage, if only a 2-point 
calibration is to be used, exit by clicking on the Calibrate button. If a 3-point 
calibration is required, continue by moving the marker to the peak channel of 
the third peak, enter its energy and click on Calibrate. The system will now be 
calibrated and the marker position will read directly in energy. 
 
To return to the uncalibrated channel mode, restore the menu and click the 
Clear Button. 
 
Spectrum Smoothing 
 
Selecting this feature performs a 3-point smoothing on the spectrum. 
The smoothing function only works on the window currently being displayed 
and does not modify data stored in the UCS-20 memory. When executed, 
smoothing performs a 3-point averaging of the data using the algorithm  
 

(n-1)+(n)+(n+1). 
3 

 
Spectrum Stripping and Background Subtraction. 
 
Spectrum stripping is a method of subtracting one spectrum from another to 
show the residual. It is normally performed on a channel-by-channel basis 
using “Normalized Live-Time”. If spectrum B has been accumulated for 1000 
sec. and spectrum A is accumulated for 100 sec., when spectrum B is stripped 
from A only 10% of the channel content of B is subtracted from A. 
This function can be useful for subtracting a background spectrum which has 
been accumulated over a long counting time from data accumulated over much 
shorter times.  
Stripping only effects the data in the display window and never changes the 
contents of the UCS-20 memory. To strip a spectrum you must first transfer the 
spectrum that will used for the stripping into the clipboard. 
 
From the Edit menu copy the spectrum into the clipboard using Edit, Copy. 
Now select and display the spectrum to be stripped and from the Edit menu 
select Strip Clipboard Spectrum. The display window will now show the 
residual after the normalized spectra are subtracted channel-by-channel. 
 

MULTICHANNEL SCALING. 
 

Multichannel Scaling provides a means of recording time correlated data such 
as half-life decay or single photon counting. In this mode the ADC is bypassed 
and incoming events are routed directly into memory.  
The UCS-20 is factory configured to use its internal amplifier and 
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discriminators to process detector signals prior to routing to the MCS counter. 
This scheme presents a convenient method of counting the complete spectrum 
or a selected range such as a single photopeak.  
First acquire a spectrum of the sample to be counted using the Pulse Height 
Analysis mode. While acquiring the spectrum, adjust the LLD and ULD to 
select the energy range of interest (For example, selecting only the 662keV 
peak from Cs-137 can eliminate unwanted background and produce a superior 
decay curve from the Cs-137/Ba-137 generator.)  
 
From the Mode menu select MCS.  
 
Select the MCS Dwell Time from the Settings menu for each memory location 
(channel). Remember the total pass time will be the dwell time times the 
conversion gain. 
Erase any current memory data and click start. The UCS-20 will proceed to 
count incoming events for the selected dwell time, store the total in the first 
channel location, reset the counter and repeat the cycle storing each total in 
sequential channels. 
 
If you wish to use an external pulse generation system such as a coincidence 
circuit, it will be necessary to bypass the on-board amplifier and 
discriminators. This mode may be selected from the Settings, EMCS menu. 
When set to the EXT position, the input BNC connector is routed directly to 
the MCS counter. When operating in this mode, the MCS input requires 
positive TTL signals (>2.5v, >150ns duration).  
 

MÖSSBAUER MODE 
 
Mössbauer mode acquisition is operationally similar to that of MCS mode. 
Multiple passes may be acquired and data for each channel summed into 
existing memory on each pass. The number of passes to overlay is determined 
by Setting the Mössbauer Passes Preset. 
 

PEAK SUMMARY 
 
If regions of interest are currently set, a table of ROI data may be displayed by 
selecting the Peak Summary report. 
 
From the Tools menu select Peak Summary. 
 
The list of ROI data for the currently selected buffer will be displayed on the 
screen in place of the spectrum. Normal acquisition may be run while in this 
mode. 
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ISOMATCH. 
 
The IsoMatch feature proves a convenient method of quickly identifying 
isotopic peaks in a spectrum relative to a master library. When the isotope is 
selected from the library, markers with the associated isotope label are 
superimposed on the spectrum at the appropriate energy positions. 
Prior to running IsoMatch, the UCS-20 must be accurately energy calibrated. 
Otherwise the peak markers will be misaligned.  

To select IsoMatch, click Tools, IsoMatch. 
 
The IsoMatch library contains a listing of significant gamma ray emissions for 
many common isotopes. 

Select the isotope of interest and click Show. Markers will be superimposed 
over the spectrum at the corresponding energies of gamma emissions for the 
selected isotope. Multiple isotopes may be displayed simultaneously by 
selecting and clicking Show. The IsoMatch library may be edited use a 
resource editor such as ResEdit.  
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SAVING and PRINTING FILES 

 
Data files may be saved and restored in binary format from disk using the 
Save, Save As, and Open commands accessed from the File menu. 
 
A Save UCS Settings command is also included which saves all current 
operating parameters such as high voltage, amplifier gain, ADC settings and 
presets. This feature can be very useful for saving and restoring specific setups 
and calibrations for different experiments. It also provides a convenient way of 
quickly restoring operating conditions after power has been removed from the 
UCS-20. 
 
Page Setup accesses the standard chosen printer setup function. 
 
Print Preferences provides a means of selecting portions of the available data 
to printing. The range of data channels may be specified if the entire spectrum 
is not required to be outputted. 
 
Print sends the selected data to the currently chosen printer. 
 

USING THE CLIPBOARD 
 

UCS-20 data may be pasted into another spectrum window or transferred in 
ASCII tab-delimited format to spreadsheets using the Clipboard function. 
Once in a spreadsheet, data may be manipulated and graphed for analysis and 
outputting to reports. Two copy commands are provided through the Edit 
menu. 
 
Copy. This command transfers the entire spectrum and header data to the 
clipboard. 
 
Copy Data Text Only. This command transfers only the spectrum channel data 
to the clipboard and is often preferred when moving data to mathematical 
analysis programs. Header information is not copied with this function. 
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NOTES 
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SPECIFICATIONS 
Physical:  Fully shielded benchtop metal 
enclosure, 9x13x2.5 in. 
HV Output: MHV (or optional SHV) 
connector supplies positive 0 - 2500 volt 
@1mA maximum current to power a 
scintillation detector. High voltage is fully 
regulated and computer controlled in 10 volt 
increments. 
Preamp In: BNC connector for direct 
connection to PMT anode signal. Uses 
internal amplifier/preamplifier. 
Amp In: BNC connector for signal 
connection to external preamplifier. 
Direct In: BNC connector for connection to 
external amplifier. Bypasses internal amplifier 
and connects directly to ADC input. Accepts 
unipolar or bipolar signals 0-8 volt range. 
Ext MCS: BNC connector to input positive 
MCS TTL pulses > 150 nsec. 5 MHz 
maximum rate. 
ROI Out: BNC connector supplies a pulse 
out when data is acquired in a channel marked 
as a ROI. The pulse width is internally 
adjustable from 100 µsec to 25 msec. The 
pulse amplitude is internally adjustable from 0 
volt to 7.5 volts. 
Gate In: BNC connector for connection to 
external coincidence unit. A positive TTL 
pulse of 50 nsec to 2 µsec width must be 
present before the peak of the input Pulse. 
MSB Out: (Optional) BNC connector to 
output the most significant MCS bit for 
Mössbauer Applications. 
T/Comp: Modular connector for connection 
to temperature compensated tube base. 
USB: Universal Serial Bus 1.1 connector for 
communication with computer. 
Preamp Power: (Optional) DB-9 connector, 
supplies + /– 12v power for external preamp.  
Amplifier: On-board combination preamp/
amplifier for use with scintillation detectors 
and PMT's. Computer controlled coarse and 
fine gain from x1 to x160. 
ADC: Wilkinson type with 80MHz clock and 
computer selected conversion gain of 2048 
1024, 512, or 256 channels. Direct input 
accepts pulse peaking times of 1 to 10 µsec. 
Includes deadtime correction when used in 
Live-Time mode. 
LLD & ULD: Independently computer 
controlled in 1%  increments over entire input 
range. Operates prior to ADC for reduced 
system dead time. 
Modes: MCA for pulse height analysis, MCS 
for half-life decay or other time related 
studies, or Mössbauer for Mössbauer 

spectroscopy studies. 
Timers: Real-Time or Live-Time operation, 
selectable in 1 sec increments, from 1 msec. 
to 60 sec. per channel in MCS mode and from   
1 µsec. to 6 sec. per channel in Mössbauer 
mode. 
Data Memory: On-board dynamic RAM, 
2048 channel x 24 bits for data, plus region-
of-interest flag. 
Deadtime:  System dead-time is computed 
and displayed on screen during acquisition. 
Power: AC line, 100-250VAC, 50/60Hz, 
autosensing internal power supply with 
Universal Power Cord input. 
Status Indicators: High voltage, Acquire, 
Activity. 
 

—– 
 
System: Operates under Macintosh System 
8.6 - 9.2.2 with USB support;  under OS X in 
Classic Emulation mode only. 
Display: Color or monochrome monitor. 
Time Presets: Preset live-time or real-time 
selection. 
Count Presets: Preset count mode for 
selected channel or gross Region-of-Interest. 
Mössbauer Passes: Number of overlapping 
passes can be specified from 1 to 99,999,999. 
ROI'S: Multiple (up to 15 different) Regions-
of Interest using color coding. 
Integral:   When cursor is in ROI, computes 
gross area, net area with end point averaging, 
centroid and FWHM. 
Energy Cal: 2-point linear or 3-point 
quadratic converts cursor position reading 
directly to energy units. (Time units in MCS 
and Mössbauer modes.) 
Subtract: Subtracts channel-by-channel time 
normalized clipboard data from display data. 
Smooth: 3-point smoothing of displayed data. 
Does not modify data in acquisition memory. 
Control: Software control of High Voltage, 
Amplifier Gain, Lower and Upper level 
discriminators, and ADC Conversion Gain. 
File: Save or load data file and header 
information in binary format. Save or Load 
instrument configuration settings. 
Clipboard: Clips data and header information 
in spreadsheet compatible format for pasting 
into other applications. 
Isomatch: Isotope library with peak markers 
and labeling for overlaying on spectrum. 
Provides quick isotope identification. 
Libraries may be edited and extended using 
Resource Editor. 
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